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1. INTENDED USE

The BD OneFlow™ ALOT (Acute Leukemia Orientation Tube) is intended for in vitro diagnostic use for
qualitative flow-cytometric immunophenotyping of immature hematopoietic cell populations (lymphoid and
myeloid lineages) on a BD flow cytometer equipped with:

e A 488-nm blue laser, a 640-nm red laser, and a 405-nm violet laser

o The ability to detect forward scatter (FSC) and side scatter (SSC)

o At least eight-color fluorescence

» Software to acquire and analyze the data

BD OneFlow™ ALOT is used as an aid in the screening of hematologically abnormal patients having, or
suspected of having, acute lymphoblastic leukemia or acute myeloid leukemia. BD OneFlow™ ALOT can be
used with peripheral whole blood and bone marrow specimens collected in EDTA or heparin. The results
should be interpreted by a pathologist or equivalent professional in conjunction with other clinical or
laboratory findings.

Specific antigens contained in BD OneFlow™ ALOT are listed as follows:

Tube FITC PE PerCP-Cy5.5 PE-Cy7 APC APC-H7 V450 V500-C

ALOT cyMPO* cyCD79a CD34 Cb19 CD7 CD3 cyCD3 CD45

a. cy refers to cytoplasmic

2. SUMMARY OF THE TEST

Acute leukemias are a heterogeneous group of diseases characterized as having a clonal (neoplastic)
population of immature hematopoietic cells in the peripheral blood (PB) or bone marrow (BM).! There are
two major classes of acute leukemias: lymphoid precursor leukemias and acute myeloid leukemias (AML).
The lymphoid precursor leukemias are divided into B-cell and T-cell precursor lymphoblastic leukemias
(BCP-ALL and T-ALL, respectively). In addition, a small number of neoplasms do not fit into any of these
categories because they either show no clear expression of markers indicative of a particular lineage, or they
express markers specific to more than one lineage. They include acute undifferentiated leukemia (AUL) and
mixed phenotype acute leukemia (MPAL).

The sample acquisition can be automated using the optional BD FACS™ Universal Loader when used with
the BD FACSLyric™ flow cytometer. This assay is not for automated sample preparation. Data analysis can
be performed using a pre-defined template and gating, however, reviewing all plots and adjusting gating
manually by the user are recommended.



Principle of Operation

The reagent tubes that comprise BD OneFlow™ ALOT are composed of monoclonal antibodies, each
conjugated to a specific fluorochrome. The specimen is added to the reagent tube and incubated, allowing
each fluorochrome-conjugated monoclonal antibody in the reagent to bind to a specific antigen. After
incubation, the FIX&PERM® Cell Fixation and Permeabilization Kit is used to fix the stained cells in
suspension and to permeabilize the cell membranes. Cells are acquired on a BD flow cytometer using the
instrument software. During acquisition, the cells travel past the laser beam and scatter the laser light. The
stained cells fluoresce. These scatter and fluorescence signals, detected by the instrument, provide
information about the cell’s size, internal complexity, and relative fluorescence intensity. The instrument
software is used to analyze the data and report the result.

3. REAGENT

Reagent Composition

BD OneFlow™ ALOT consists of two single-use tubes containing fluorochrome-conjugated antibodies in an
optimized dried formulation. The BD OneFlow™ ALOT (S) tube contains antibodies that recognize cell
surface antigens, and the BD OneFlow™ ALOT (C) tube contains antibodies that recognize cytoplasmic
antigens. All of the antibodies have IgG1 heavy chains and kappa light chains. The antibody clone names
are shown beneath the antibody.

Table 1 Antibody composition of BD OneFlow™ ALOT

Reagent FITC PE PerCP-Cy5.5 PE-Cy7 APC APC-H7 V450° V500-C®
ALOT (S) - - CD34 CD19 cD7 CD3 - CD4s
(8G12)? (5125-C1)** | (M-T701)° | (SK7)®7 (2D1)%°
ALOT () cyMPO CD79a - - - - cD3 -
(MPO-7)"° | (HM57)" (UCHT-1)3"2
a. BD Horizon™ V450, BD Horizon™ V500-C

The antibodies in the BD OneFlow™ ALOT tubes were chosen for their ability to identify and characterize
aberrant immature populations of hematopoietic cells.

Refer to the article describing the EuroFlow antibody pomels1 for a full description of the utility of the
antibodies chosen for the reagent tubes.

Precautions

* The reagent tubes contain 0.70% 2-methyl-4-isothiazolin-3-one (CAS number 2682-20-4). These reagents
are classified as hazardous according to the Globally Harmonized System of Classification and Labelling
of Chemicals (GHS) and Regulation (EC) No 1272/2008.




Warning

H317: May cause an allergic skin reaction.

H412: Harmful to aquatic life with long lasting effects.

Prevention P261: Avoid breathing dust/fume/gas/mist/vapors/spray.
P272: Contaminated work clothing should not be allowed out of the workplace.
P273: Avoid release to the environment.

P280: Wear protective gloves/protective clothing/eye protection/face protection.

Response P302+P352: IF ON SKIN: Wash with plenty of soap and water.
P333+P313: If skin irritation or rash occurs: Get medical advice/attention.

P362+P364: Take off contaminated clothing and wash it before reuse.

Disposal P501: Dispose of contents/container to an approved facility in accordance with local, regional,

national and international regulations.

* Go to regdocs.bd.com/regdocs/sdsSearch to download the Safety Data Sheet.

Storage and Handling

o Store tubes at 2-27 °C in the foil pouch.

« Do not freeze the reagent or expose it to direct light at any time during storage or incubation with cells.

e The dried fluorochrome-conjugated antibodies are stable until the expiration date shown on the pouch
and tube labels when stored as directed. Do not use after the expiration date.

o Once the pouch is opened, the dried fluorochrome-conjugated antibodies are stable for one month when
stored as directed.
CAUTION Ensure the pouch is completely resealed after removing a tube. The reagent is very sensitive
to moisture. Do not remove the desiccant from the reagent pouch.

4. INSTRUMENTS

The recommended BD systems are outlined. See the following table. See the corresponding reagent or
instrument user documentation for details.

Table 2 Recommended BD systems

Flow cytometer

Setup beads

Setup software

Analysis software

BD FACSLyric™®

BD® CS&T Beads
BD® FC Beads 7-Color Kit
BD® FC Beads 5-Color Kit

BD® FC Beads 2-Color Kit (12-

color instrument)

BD FACSuite™ Clinical

application v1.4 or later”

BD FACSuite™ Clinical
application v1.4 or later

BD FACSCanto™ II°

BD FACSDiva™ CS&T IVD
Beads

BD OneFlow™ Setup Beads

BD® FC Beads 8-Color Kit for
BD OneFlow™ Assays

BD FACSDiva™ software
v8.0.1 or later

BD FACSDiva™ software
v8.0.1 or later



http://regdocs.bd.com/regdocs/sdsSearch

Flow cytometer Setup beads Setup software Analysis software

a. 8-color (4-Blue 2-Red 2-Violet), 10-color (4-Blue 3-Red 3-Violet), or 12-color (4-Blue 3-Red 5-Violet)
b. The Loader can be used with BD FACSuite™ Clinical application v1.5 or later
c. 3-laser, 8-color, 4-2H-2V BD default (4-2H-2V) optical configuration

The BD FACS™ Universal Loader can be used with these products. See the BD FACSLyric™ System
Instructions For Use for more information. The Loader can be used with BD FACSuite™ Clinical application
v1.5 or later.

5. SPECIMEN COLLECTION AND PREPARATION

BD OneFlow™ ALOT can be used for immunophenotyping by flow cytometry of peripheral blood (PB) or
bone marrow (BM) aspirates.

¢ Collect PB specimens aseptically by venipuncture in BD Vacutainer® K2 or K3 EDTA blood collection
tubes, or equivalent, or in lithium or sodium heparin.'®

» Collect BM specimens in BD Vacutainer® K2 or K3 EDTA blood collection tubes, or equivalent, or in lithium
or sodium heparin.
We recommend that you follow guidelines described in consensus protocols for flow cytometric
immunophenotyping of hematopoietic mtzllign(lncies.m’15

* Specimens should be processed up to 24 hours after collection.

Specimens with large numbers of nonviable cells can give erroneous results due to selective loss of
populations and to increased nonspecific binding of antibodies to nonviable cells. Viability of specimens
should be assessed. A minimum viability of 75% is recommended."®

» Samples should be acquired within 60 minutes of staining if kept at room temperature, protected from
light.
WARNING All biological specimens and materials coming in contact with them are considered
biohazards. Handle as if capable of transmitting infection'”"® and dispose of with proper precautions in
accordance with federal, state, and local regulations. Never pipette by mouth. Wear suitable protective
clothing, eyewear, and gloves.

Interfering Conditions

Substances present in the specimen might interfere with the assay:

» Use of therapeutic monoclonal antibodies in patient treatment, such as Rituximab and Alemtuzumab,
can interfere with recognition of target antigens by this reagent or deplete the clinically relevant cell
populations. This should be considered when analyzing samples from patients treated in this fashion.
BD Biosciences has not characterized the effect of the presence of therapeutic antibodies on the
performance of this reagent.

« Avoid using potentially compromised specimens, including clotted, hemolyzed, frozen, or refrigerated
specimens.

The table lists the substances that were tested for interference with BD OneFlow™ ALOT.

Testing for interference was performed in accordance with CLSI guidelines.19 There was no detectable
interference at the following concentrations.



Table 3 Test concentrations for exogenous interferents

Exogenous interferent

Concentration tested

Acetaminophen

0.156 mg/mL

Acetylsalicylic acid (Aspirin)

0.03 mg/mL

Albuterol 0.000045 mg/mL
Guaifenesin 0.0045 mg/mL
Ibuprofen 0.219 mg/mL

Oseltamivir phosphate

0.000399 mg/mL

Table 4 Test concentrations for endogenous interferents

Endogenous interferent

Highest expected concentration

Hemoglobin or hemolysate 10 mg/mL
Albumin or total protein 60 mg/mL
Bilirubin, conjugated 0.4 mg/mL
Bilirubin, unconjugated 0.4 mg/mL
Triglycerides 15 mg/mL
Erythrocytes 6x10° cells/plL

6. PROCEDURE

Reagents and Materials

Reagents and materials provided

BD OneFlow™ ALOT is provided as single-use tubes in foil pouches. Each kit contains four pouches:

« two pouches, each containing five tubes of BD OneFlow™ ALOT (S)
» two pouches, each containing five tubes of BD OneFlow™ ALOT (C)

Reagents and materials required but not provided

For BD FACSLyric™ flow cytometers:

e BD OneFlow™ Assays Installer I (Catalog No. 664226)

An installer is required for the BD OneFlow™ ALOT assay. If you are using the Loader, use BD OneFlow™
Assays Installer I v1.1 to install the assay in BD FACSuite™ Clinical application v1.5 or later. The assay
comprises an acquisition sheet, a laboratory report, a physician report, and a supplemental report used
for further investigation. Unless you already have the current BD OneFlow™ ALOT assay, you will have to
order the installer for BD OneFlow™ Assays the first time you order BD OneFlow™ ALOT.

The BD OneFlow™ Application Guide for Acute Leukemias for BD FACSLyric™ Flow Cytometers is provided

with the installer.




For BD FACSCanto™ II flow cytometers:
e BD OneFlow™ Assay Templates Installer (Catalog No. 659305)

An installer is required for the BD OneFlow™ ALOT template. The template contains two global
worksheets: the BD OneFlow™ ALOT Acquisition worksheet and the BD OneFlow™ ALOT Analysis
worksheet. Unless you already have the current BD OneFlow™ ALOT template, you will have to order the
installer the first time you order BD OneFlow™ ALOT. The installer also contains the BD OneFlow™ Setup
template and templates for other BD OneFlow™ reagents.

The Instrument Setup Guide for BD OneFlow™ Assays and the BD OneFlow™ Application Guide for Acute
Leukemias are provided with the installer.

15-mL conical polypropylene tubes

40-pum cell strainer (if needed for processing BM specimens)

Pasteur pipet

Serological pipet

Micropipettor with tips

Vortex mixer

Centrifuge

Wash buffer (filtered phosphate buffered saline (PBS) + 0.5% bovine serum albumin (BSA) + 0.09% or
0.1% sodium azide)

o FIX&PERM® Cell Fixation and Permeabilization kit

o (Optional) BD FACS™ Universal Loader
NOTE Labs must validate any deviations from the following procedures.

Installing the Assay or Template

The BD OneFlow™ Assay Installer, used with BD FACSuite™ Clinical application, or the BD OneFlow™ Assay
Template Installer, used with BD FACSDiva™ software, has to be installed before you run the assay for the
first time. Additional assays or templates can be installed at the same time, as needed. If you will analyze
the FCS files on a different workstation from the one used to acquire the samples, ensure that you install
the assays or templates on both workstations.

To install the BD OneFlow™ assay in BD FACSuite™ Clinical application:

NOTE When you select an assay to install, it will overwrite the BD OneFlow™ assay that was previously
installed on the system. If you do not want an existing assay on your computer to be overwritten, do not
select that assay from the installer during the installation process.

1. Insert the installer and click the installer icon.
The InstallShield Wizard for BD OneFlow™ Assays opens.
2. Click Next.

The license agreement opens.

Select the I accept the terms in the license agreement option and click Next.
To install all of the assays included on the installer, select the Complete option and click Next.

& W

5. Optional: To install a subset of the assays included on the installer, select the Custom option and click
Next.

The Custom Setup dialog opens.

o Click the menu to the left of the appropriate assay.
o From the menu, select This assay will be installed on your local hard drive.



9.
10.

Click Install.

The assays will be installed in the Library.

Click Finish.

The InstallShield Wizard closes.

Optional: Double-click the ReadMe file found on the installer.

The ReadMe file opens.

Click the close box when finished reading it.
Remove the installer.

To install the OneFlow template in BD FACSDiva™ software:

NOTE When you select a template to install, it will always overwrite any template with the same name
that was previously installed on the system. If you do not want an existing template on your computer to be
overwritten, do not select that template from the installer during the installation process.

1.
2.

3.
4.
5.

Insert the installer and click the installer icon.
Follow the instructions in the dialog.

The installer will copy and paste the templates in the folder D:\BDExport\Templates\Panel\BD Panels.
NOTE If your system has only one drive, the templates will be installed in

C:\BDExport\Templates\Panel\BD Panels.

After installation is complete, a dialog opens, summarizing which templates have been successfully
copied into the folder.

Click OK to close the dialog.
The installer ReadMe file opens. Click the close box when you have finished reading it.
Remove the installer.

Setting up the Cytometer

For BD FACSLyric™ flow cytometers:

1.

Use BD® CS&T Beads and BD FACSuite™ Clinical application v1.4 or later, to perform Characterization
QC (CQQ) every 6 months or as needed, perform daily Performance QC (PQC), and perform daily assay
and tube settings setup. For assay and tube settings setup, select the Run Setup and Generate Reports
checkboxes.

Use the BD® FC Beads 7-Color Kit, BD® FC Beads 5-Color Kit, and BD FACSuite™ Clinical application v1.4
or later, to update reference settings every 60 days. In addition, use the BD® FC Beads 2-Color Kit to set
up a 12-color instrument.

See the BD FACSLyric™ System Instructions For Use, the BD FACSLyric™ Clinical Reference System, and
the appropriate reagent IFU for more information.

For BD FACSCanto™ II flow cytometers:

1.

2.

Use BD FACSDiva™ CS&T IVD Beads (CS&T IVD beads) and BD FACSDiva™ software v8.0.1 or later, to
define the baseline of the cytometer and to run a daily performance check of the cytometer.

Use BD OneFlow™ Setup Beads, lysed washed blood, and BD FACSDiva™ software v8.0.1 or later, to set
photomultiplier tube (PMT) and scatter voltages monthly.

Use BD® FC Beads and BD FACSDiva™ software v8.0.1 or later, to set fluorescence compensation
monthly.

We recommend that you confirm that the PMT voltages (PMTVs) are still within their daily target ranges.



See the Instrument Setup Guide for BD OneFlow™ Assays and the appropriate reagent IFU for more
information.

Staining the Specimen

NOTE Before staining the specimen, confirm that the cytometer has been properly set up.

1.

10.
11.
12.
13.

14.
15.

16.
17.
18.
19.
20.

21.

22.

If the pouches are stored refrigerated, allow them to reach room temperature before opening them.

NOTE The reagent is very sensitive to moisture. To avoid condensation, open the pouches only if they
are at room temperature.
For each patient specimen, remove a BD OneFlow™ ALOT (S) tube from its pouch. Do not remove the
BD OneFlow™ ALOT (C) tube from its pouch at this time.
Place the tubes in a rack, protected from light.

Start staining the specimen within one hour of removing a tube from the pouch.
Immediately reseal the pouch with any unused tubes.

NOTE Ensure that the pouch is completely resealed after removing a tube. The reagent is very
sensitive to moisture. Do not remove the desiccant from the reagent pouch.

The reagent is very sensitive to light. Start staining the specimen immediately.
Write the patient ID on the tube label within the area provided.

NOTE Write the current date on the pouch label when it is first opened. Use the tubes from that
pouch within one month before opening the next pouch.

Prepare each specimen as described.
* For PB specimens, invert the collection tube 10 times to mix well.

* For BM specimens, invert the collection tube 10 times to mix well. Verify that the specimen is not
lipemic and does not have particulate matter in it.

—If needed, pass sufficient specimen through a 40-um cell strainer.
Add 50 pL of wash buffer and 50 pL of unwashed specimen to the BD OneFlow™ ALOT (S) tube.

NOTE Staining from 5 x 10° to 4 x 10" white blood cells/mL gives equivalent results.

Vortex vigorously 3-5 seconds to mix well.

Incubate for 30 minutes at 20-25 °C, protected from light.

Add 1.5 mL of wash buffer. Vortex vigorously 3-5 seconds to mix well.

Add an additional 1.5 mL of wash buffer. Vortex gently to mix.

Centrifuge at 540g for 5 minutes at 20-25 °C.

Remove the supernatant without disturbing the cell pellet, leaving approximately 50 pL of residual liquid
in the tube.

Vortex vigorously until the cell pellet is completely resuspended.

Add 100 pL of FIX&PERM Reagent A (fixation solution) to the tube. Vortex vigorously 3-5 seconds to
mix well.

Incubate for 15 minutes at 20-25 °C, protected from light.

Add 1.5 mL of wash buffer. Vortex vigorously 3-5 seconds to mix well.

Add an additional 1.5 mL of wash buffer. Vortex gently to mix.

Centrifuge at 540g for 5 minutes at 20-25 °C.

Remove the supernatant without disturbing the cell pellet, leaving approximately 50 pL of residual liquid
in the tube.

Vortex vigorously until the cell pellet is completely resuspended.

NOTE If you are unable to obtain a single-cell suspension, see Troubleshooting.

Measure the volume in each tube using a pipet and add wash buffer to give a final volume of 100 plL in
each tube. Vortex 3-5 seconds to mix well.



23.

24,

25.
26.

27.
28.
29.
30.
31.
32.

33.
34.

NOTE It isimportant to have a final volume of 100 pL in each tube so that all of the cells will be
completely permeabilized in steps 25-28.

Remove the appropriate number of BD OneFlow™ ALOT (C) tubes from the pouch and reseal the pouch
immediately.

NOTE Ensure that the pouch is completely resealed after removing a tube. The reagent is very sensitive
to moisture. Do not remove the desiccant from the reagent pouch.

NOTE Write the current date on the pouch label when it is first opened. Use the tubes from that pouch
within one month before opening the next one.

Write the patient ID on the BD OneFlow™ ALOT (C) tube label within the area provided.

Add 100 pL of FIX&PERM Reagent B (permeabilization solution) to the BD OneFlow™ ALOT (C) tube.

Transfer 100 pL of the sample from the BD OneFlow™ ALOT (S) tube to the corresponding BD OneFlow™
ALOT (C) tube.

NOTE Make sure that the patient ID numbers on the two tubes are the same.

Vortex the BD OneFlow™ ALOT (C) tube vigorously 3-5 seconds to mix well.
Incubate for 15 minutes at 20-25 °C, protected from light.

Add 1.5 mL of wash buffer. Vortex vigorously 3-5 seconds to mix well.

Add an additional 1.5 mL of wash buffer. Vortex gently to mix.

Centrifuge at 540g for 5 minutes at 20-25 °C.

Remove the supernatant without disturbing the cell pellet, leaving approximately 50 pL of residual liquid
in the tube.

Vortex 3-5 seconds to resuspend the cell pellet.
Add 250 plL of wash buffer to the tube to give a final volume of 300 pL. Vortex 3-5 seconds to mix well.

NOTE Samples should be acquired within 60 minutes of staining if kept at room temperature,
protected from light.

Setting up the Assay (BD FACSLyric™ Flow Cytometer)

To add a reagent lot ID and expiration date to the library:

1.

From the BD FACSuite™ Clinical application navigation bar, click the Library icon.

The Library workspace opens.

Expand the Beads and Reagents menu and select Reagents.
Select OneFlow ALOT from the Product Name list.

The OneFlow ALOT pane opens at the bottom of the page.
Click Add Lot.
The Add New Lot dialog opens.

In BD FACSuite™ Clinical application v1.5, click Scan Barcode and then scan the barcode on the pouch
or tube label.

The Lot ID and expiration date are entered in the appropriate fields.

Make sure to add the Lot ID and expiration date for both tubes, BD OneFlow™ ALOT (S) and
BD OneFlow™ ALOT (C).

NOTE In BD FACSuite™ Clinical application v1.4, add the Lot ID and expiration date manually.
Select the Current Lot checkbox.



7.

Click OK.
The lot ID and expiration date are added to the appropriate columns for the reagent.

NOTE Make sure to add the reagent lot and expiration date prior to acquisition. This has to be done
only once for a particular reagent lot.

To create a worklist:

1.

5w

From the BD FACSuite™ Clinical application navigation bar, click the Worklists icon.
The Worklists workspace opens.
In the Manage Worklists tab, click New.

A blank worklist opens in a new tab.

In the Worklist Entries section, select the appropriate task from the Task menu.
Enter the Sample ID for BD OneFlow™ reagent tasks.

Do not scan the barcode, found on the tube label, into the software.

NOTE Multiple lots of reagent cannot be run on the same worklist.
In the Loading Options section, select Manual from the Loading Option menu.

See the BD FACSLyric™ System Instructions For Use for more information.

Setting up the Experiment (BD FACSCanto™ II Flow Cytometer)

1.

2.
3.

o v

10.
11.

12.

From the menu bar, select Edit > User Preferences, then navigate to the FCS tab, and select Export FCS
after recording, to automatically export the FCS files after acquisition. Click OK.
Confirm that the cytometer is in the 4-2H-2V BD default configuration.

From the menu bar, select Experiment > New Experiment > Blank Experiment. Click OK.

NOTE You can also create an experiment directly from the Browser using the Experiment icon.

If prompted by the CST Mismatch dialog, select Use CST Settings.
Rename the experiment according to your laboratory practice.

. In the Browser, right-click Cytometer Settings > Link Setup and select the appropriate compensation

matrix calculated using BD® FC Beads within the past 31 days. Click Link.

See the BD® FC Beads 8-Color Kit for BD OneFlow™ Assays IFU or the Instrument Setup Guide for
BD OneFlow™ Assays.

If prompted by the Cytometer Settings Mismatch dialog, select Overwrite.

Right-click Cytometer Settings > Unlink From and select the previously linked compensation setup. Click
oK.

NOTE Unlinking the compensation setup allows updated application settings to be applied while
retaining compensation values.

In the Browser, right-click Cytometer Settings > Application Settings > Apply and select the most
recent application settings determined within the last 31 days using the BD OneFlow™ Setup Beads. Click
Apply.

A Confirm dialog opens. Select Keep the compensation value.

If prompted by the Confirm Cytometer Changes dialog, click Yes to overwrite the cytometer values for
FSC Area Scaling.

From the menu bar, select Experiment > New Specimen.

The Panel Templates dialog opens.

10



13.
14.

15.

16.
17.

18.
19.

Navigate to the BD Panels tab and select the OneFlow ALOT template.
Indicate the number of patient specimens you want to acquire using the Copies field near the bottom of
the BD Panels tab. Click OK.

Rename each specimen, for example, with the appropriate patient ID in front of the specimen name.

NOTE If you have to re-run a particular patient sample, set the current tube pointer to the tube you
wish to re-run. Click Next Tube in the Acquisition Dashboard to create another tube for that patient. Do
not select Experiment > New Tube from the menu bar or use the New Tube icon from the Browser
menu bar to create the additional tube to be acquired because the labels and barcode fields will not be
populated.

NOTE If you want to acquire additional patient samples in the experiment, repeat steps 12-15 to add
new specimens. Two Confirm dialogs will open asking if you want to create another BD OneFlow™ ALOT
acquisition worksheet or another BD OneFlow™ ALOT analysis worksheet. Click Cancel in each dialog.

From the menu bar, select Experiment > Experiment Layout and navigate to the Keywords tab.

Highlight the Product ID keyword for the appropriate tube, and scan the barcode on the BD OneFlow™
ALOT (C) tube label.

NOTE If you cannot scan the barcode on the tube label, see Troubleshooting on page 24.

Manually add the appropriate information to the remaining keywords, as needed.
Click OK to close the Experiment Layout.

Acquiring the Stained Sample

For BD FACSLyric™ flow cytometers:

Two versions of the assay are available:

Assay version Software Stopping time Acquisition mode
v1.0 BD FACSuite™ Clinical application v1.4 or later 5 minutes Manual
v1.1 BD FACSuite™ Clinical application v1.5 or later 3 minutes Manual, Loader

The assay will automatically collect 100,000 total events. You cannot append the number of events to
collect after acquisition has started. Therefore, if needed, change the number of events to collect before you
start acquisition. To change the number of events to collect, see the BD OneFlow™ Application Guide for
Acute Leukemias for BD FACSLyric™ Flow Cytometers. A clinically relevant number of cells can be determined
at the discretion of an appropriate healthcare professional.

To acquire the sample using BD OneFlow™ ALOT assay v1.1:

1.

In the Worklist Controls bar, select Run All from the Run menu to run the entire worklist from the
beginning.

Alternatively, to acquire a specific tube, set the run pointer to the sample you want to run and select Run
from Pointer from the Run menu.

Vortex each stained tube 3-5 seconds at low speed immediately prior to acquisition.

If using the BD FACS™ Universal Loader, vortex tubes immediately before placing them in the Loader
racks.

11



NOTE Make sure that all of the BD OneFlow™ tubes in the rack are acquired within 1 hour. If not, you
must validate tubes acquired outside the 1 hour time.

Follow the prompts in the software to load or unload tubes.

The BD OneFlow™ ALOT Acquisition sheet opens. The acquisition sheet contains dot plots and gates to
identify Cells, Leukocytes, and CD45"™""™.

Examine each dot plot on the acquisition sheet.
NOTE The preview time is 10 seconds and then data is automatically recorded. Do not increase the

preview time and risk loss of the sample due to insufficient volume.

NOTE The assay will automatically collect 100,000 total events. If the assay cannot collect 100,000
total events, acquisition will stop after 3 minutes. A QC message, “All Events gate does not contain the
requested 100,000 events” is generated in the Lab Report, and can be ignored if the sample can be
analyzed using the events acquired.

See the BD FACSLyric™ System Instructions For Use for more information.

To acquire the sample using BD OneFlow™ ALOT assay v1.0:

. In the Worklist Controls bar, select Run All from the Run menu to run the entire worklist from the

beginning.

Alternatively, to acquire a specific tube, set the run pointer to the sample you want to run and select Run
from Pointer from the Run menu.

Vortex each tube 3-5 seconds at low speed immediately prior to acquisition.

Follow the prompts in the software to load or unload tubes.

The BD OneFlow™ ALOT Acquisition sheet opens. The acquisition sheet contains dot plots and gates to
identify Cells, Leukocytes, and CD45™""™.

Examine each dot plot on the acquisition sheet.

NOTE The preview time is 10 seconds and then data is automatically recorded. Do not increase the
preview time and risk loss of the sample due to insufficient volume.

If it appears that fewer than 100,000 events will be collected, monitor the sample volume and click Stop
Tube in the Worklist Controls bar to stop acquisition before the tube runs dry.

NOTE The assay will automatically collect 100,000 total events. If the assay cannot collect 100,000
total events, acquisition will stop after 5 minutes. However, make sure you monitor the sample volume
and click Stop Tube in the Worklist Controls bar to stop acquisition before the tube runs dry. To change
the stopping criteria, see the BD OneFlow™ Application Guide for Acute Leukemias for BD FACSLyric™
Flow Cytometers.

See the BD FACSLyric™ System Instructions For Use for more information.

For BD FACSCanto™ II flow cytometers:

5.

1. Inthe Browser, expand the appropriate specimen and set the current tube pointer to that tube.

2. Select the BD OneFlow™ ALOT Acquisition worksheet tab.

3.

4. Install the tube on the cytometer. Adjust the flow rate to Medium in the Acquisition Dashboard. Click

Vortex the stained tube 3-5 seconds at low speed.
Acquire Data.

Verify that the population is on scale and adjust the gate in the first plot of the acquisition worksheet to
exclude debris, if needed.
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6. Click Record Data in the Acquisition Dashboard to collect total events.

NOTE The template automatically collects 100,000 total events.” Use the menu in the Acquisition
Dashboard to select a different number of events to acquire, if needed. A clinically relevant number of
cells can be determined at the discretion of an appropriate healthcare professional.

7. Inspect the dot plots on the acquisition worksheet, and adjust the gates as needed.
Some of the dot plots might look different from those in other experiments. The initial FSC-A vs SSC-A
dot plot to identify cells and eliminate debris may appear compressed. This is a consequence of the

target values used to create the application settings. The values are specified by the EuroFlow
Consortium.

NOTE Enlarge the dot plots while adjusting the gates so you can more readily see the populations of
interest. After adjusting the gates, collapse the dot plot to its original size.
The FSC-A vs SSC-A dot plot is used to identify cells.

The CD45 V500-A vs SSC-A dot plot from the Cells population is used to identify leukocytes.

neg/dim

The CD45 V500-A vs SSC-A dot plot from the Leukocytes population is used to identify the CD45
population.

The remaining dot plots do not contain gates and are included to assess staining of the CD45™Y"™

population with all of the antibodies, therefore serving as an internal quality control for the tube.

NOTE See the BD OnefFlow™ Application Guide for Acute Leukemias for examples of the dot plots
showing populations of normal cells in the acquisition worksheet.

8. Continue until all of the tubes have been acquired.
9. From the menu bar, select File > Export > Experiments, and select the Directory Export option. Click OK.

Analyzing the Data Using BD FACSuite™ Clinical Application

NOTE FCS files acquired using BD OneFlow™ ALOT assay v1.0 can be opened in BD OneFlow™ ALOT assay
v1.1.

1. Set the run pointer to the appropriate sample in the Worklist Entries panel.
The BD OneFlow™ ALOT Laboratory Report opens in the Laboratory Report tab.
2. Review the BD OneFlow™ ALOT Laboratory Report.

The first page of the laboratory report shows sample and tube information, population statistics, and QC
messages, if generated.

NOTE Populations with a low number of events might report %Parent or %Grandparent as 0.0%. This is
due to rounding the result to a single decimal place in BD FACSuite™ Clinical application.
3. Inspect the dot plots on page 2 of the laboratory report and adjust the gates as needed.

The dot plots on page 2 of the laboratory report provide a high level cell analysis, identifying FSC
Singlets, SSC Singlets, Leukocytes, and CD45™¥“™ cells.

NOTE Enlarge the dot plots while adjusting the gates so you can more readily see the populations of
interest. After adjusting the gates, collapse the dot plot to its original size.

See the BD OneFlow™ Application Guide for Acute Leukemias for BD FACSLyric™ Flow Cytometers for
examples of dot plots showing populations of normal cells.

4. Inspect the dot plots on page 3 of the laboratory report and adjust the gates as needed.
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10.
11.

12.
13.
14.

15.

16.

The dot plots on page 3 of the laboratory report are used to identify and analyze the T cells and B cells
in the sample.

Inspect the dot plots on page 4 of the laboratory report and adjust the gates as needed.

The dot plots on page 4 of the laboratory report are used to identify and analyze the Non-Lymphoid cells
in the sample.

Inspect the dot plots on page 5 of the laboratory report and adjust the gates as needed.

neg/dim

The dot plots on page 5 of the laboratory report are used to identify and analyze the CD45 cellsin

the sample.
Inspect page 6 of the laboratory report.

Page 6 of the laboratory report includes lot and expiration dates for BD® CS&T Beads and the
BD OneFlow™ reagent, reference settings, tube settings, and cytometer configuration.

(Optional) Select the Physician Report tab to view the report.
The BD OneFlow™ ALOT Physician Report contains a high level summary of the assay results.

(Optional) Select the Supplemental Report tab to add additional dot plots to further analyze the
sample.

See the BD OneFlow™ Application Guide for Acute Leukemias for BD FACSLyric™ Flow Cytometers for
more information.

WARNING Any gated regions deleted in this Supplemental Report are reflected in the Laboratory and
Physician Reports. Any gated regions created in this Supplemental Report might be reflected in the
Laboratory Report.

WARNING Do not add dot plots or gates to the Laboratory Report or Physician Report. They cannot be
deleted and will invalidate the report.

Select the Laboratory Report tab.
Click E-Sign.
The E-Signature dialog opens.

Select a user ID.
Type your password.
(Optional) Enter any comments.

Click Sign.

The dialog closes and the signer’s user ID, date and time, and comments are added to the E-signature
box in all three reports.

Click Approve.

The Laboratory and Physicians Reports are automatically exported to C:\BD Export Clinical. If needed,
manually export the Supplemental Report.

See the BD FACSLyric™ System Instructions For Use for more information and export options.

Analyzing the Data Using BD FACSDiva™ Software

1.
2.

From the menu bar, select File > Import > Experiments.
Select the experiment that you want to analyze. Click Import.
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The experiment with the associated acquisition and analysis worksheets opens.

. Select the BD OneFlow™ ALOT Analysis worksheet tab.

. Inspect the dot plots on page 1 of the analysis worksheet, and adjust the gates as needed.

Some of the dot plots might look different from those in other experiments. The initial FSC-A vs SSC-A
dot plot to identify cells and eliminate debris may appear compressed. This is a consequence of the

target values used to create the application settings. The values are specified by the EuroFlow
Consortium.

NOTE Enlarge the dot plots while adjusting the gates so you can more readily see the populations of
interest. After adjusting the gates, collapse the dot plot to its original size.

The first three dot plots on page 1 of the analysis worksheet identify cells, FSC singlets, and SSC singlets.
Debris and doublets are excluded by adjusting the gates.

Examine the Leukocytes population in the CD45 V500-A vs SSC-A dot plot from the SSC Singlets gate.
Examine the CD45"¥“™ population in the CD45 V500-A vs SSC-A dot plot from the Leukocytes gate.
The CD34 PerCP-Cy5.5-A vs SSC-A dot plot does not have a gate and is used for informational purposes.
NOTE See the BD OnefFlow™ Application Guide for Acute Leukemias for examples of dot plots showing
populations of normal cells in the analysis worksheet.

. Inspect the dot plots identifying T cells on the top half of page 2 of the analysis worksheet, and adjust

the gates as needed.

Cells expressing cytoplasmic CD3 (cyCD3") are identified in the cyCD3 V450-A vs SSC-A dot plot from the
Leukocytes population.

T cells are identified in the CD3 APC-H7-A vs cyCD3 V450-A dot plot from the cyCD3" population. The
cyCD3" cells are characterized in the remaining dot plots.

. Inspect the dot plots identifying B cells on the bottom half of page 2 of the analysis worksheet, and
adjust the gates as needed.

CD19" cells are identified in the CD19 PE-Cy7-A vs SSC-A dot plot from the Leukocytes population.

B cells are identified in the cyCD79a PE-A vs CD19 PE-Cy7-A dot plot from the CD19" population. The
CD19" cells are characterized in the remaining dot plots.

. Inspect the dot plots identifying non-lymphoid cells on page 3 of the analysis worksheet, and adjust the
gates as needed.

Non-lymphoid cells are identified in the CD45 V500-A vs SSC-A dot plot from the NOT(cyCD3" OR CD19")
population.

Cells expressing cytoplasmic myeloperoxidase (cyMPQ") are identified in the cyMPO FITC-A vs SSC-A dot
plot from the Non-Lymphoid population. The non-lymphoid cells are characterized in the remaining dot
plots.

neg/dim

. Inspect the dot plots identifying CD45
gates as needed.

cells on page 4 of the analysis worksheet, and adjust the

CD45™"™ cells are identified in the CD45 V500-A vs SSC-A dot plot from the Leukocytes population.
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10.

11.

12.
13.

7.

CD45™"™CD34" cells are identified in the CD34 PerCP-Cy5.5-A vs SSC-A dot plot from the CD45™¥"™
population.

The remaining dot plots present the expression of each of the markers in combination with CD34 for the
CD45™Y™ population.

Examine the results in the statistics box on page 5 of the analysis worksheet.

Confirm that all of the keywords are present in the statistics box. If any of the keywords are missing, see
Troubleshooting on page 24.

Perform further analyses as needed.

NOTE The gates in the dot plots of the analysis worksheet are provided for analyzing normal and
aberrant cell populations in the specimen. Aberrant cell populations will require further analysis.

Save the BD OneFlow™ ALOT analysis worksheet as a PDF.

NOTE The BD OneFlow™ ALOT analysis worksheet is a global worksheet. Any gates that are adjusted
when analyzing a sample on a global worksheet will be changed in previously analyzed files. Previously
saved PDFs will not change, but if you go back to a previously analyzed global worksheet, you will have
to readjust the gates so they match what they were before.

(Optional) Click Print to print the analysis worksheet.
Analyze the next sample.

RESULTS

Representative Data

See the appropriate application guide to see laboratory reports showing dot plots from a hematologically
normal adult sample stained with each reagent.

For BD FACSLyric™ flow cytometers:

e BD OneFlow™ Application Guide for Acute Leukemias for BD FACSLyric™ Flow Cytometers
For BD FACSCanto™ II flow cytometers:

8.

9.

BD OneFlow™ Application Guide for Acute Leukemias
LIMITATIONS

Use of this reagent for diagnostic evaluation of hematologic disorders should be performed in the
context of a thorough immunophenotypic analysis including other relevant markers.

Use of BD OneFlow™ ALOT requires experience with leukemia and lymphoma immunophenotyping and
classification. The results should be interpreted by a pathologist, or equivalent professional, in
conjunction with other clinical or laboratory findings.

BD OneFlow™ ALOT has not been tested on specimens from patients with minimal residual disease
(MRD).

PERFORMANCE CHARACTERISTICS

Specimen handling and collection (AOB/AOS)

A study was performed to assess the Age of Blood (AOB) and Age of Stain (AOS) using BD OneFlow™ ALOT.
The stability of EDTA- or heparin-anticoagulated peripheral blood or bone marrow specimens was evaluated
by assessing the combined effect of:
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o AOB: time duration between specimen collection and staining

e AOS: time duration between completion of stained sample processing and acquisition with the flow
cytometer.

Specimens were tested up to 24 hours post collection and stained samples were tested up to 3 hours post

stain. All samples were maintained at room temperature before staining or acquisition.

Based on the results of this study, we recommend staining samples within 24 hours of collection and
acquiring samples within 1 hour of staining if the sample is kept at 20-25 °C.

BD FACSLyric™ Flow Cytometer
Method comparison, BD FACSLyric™ vs BD FACSCanto™ II flow cytometer

A method comparison study between the BD OneFlow™ system on the BD FACSLyric™ flow cytometer
(Investigational Method) and the BD OneFlow™ system on the BD FACSCanto™ II flow cytometer
(Comparator Method) was performed at 3 clinical sites. The BD OneFlow™ system on BD FACSLyric™
comprises BD® CS&T Beads, BD® FC Beads 7-Color Kit, BD® FC Beads 5-Color Kit, and BD OneFlow™ ALOT
acquired on a 10-color BD FACSLyric™ flow cytometer (4-Blue 3-Red 3-Violet) using BD FACSuite™Clinical
application v1.3 and the BD OneFlow™ ALOT assay. (A regression study was performed, demonstrating
equivalence between BD FACSuite™ Clinical application v1.3 and v1.4.) The BD OneFlow™ reference system
on BD FACSCanto™ II comprises BD FACSDiva™ CS&T IVD Beads, BD OneFlow™ Setup Beads, BD® FC Beads
8-Color Kit for BD OneFlow™ Assays, and BD OneFlow™ ALOT acquired on a BD FACSCanto™ II flow
cytometer (4-2H-2V) using BD FACSDiva™ software v8.0.2 and the BD OneFlow™ ALOT template. A total of
26 evaluable PB specimens and 28 evaluable BM specimens were enrolled in the study. Specimens were
collected in the anticoagulants shown. See the following table.

Table 5 Anticoagulants used to collect specimens

Anticoagulant
Specimen type EDTA Heparin
PB (lymphoid) 12 2
PB (non-lymphoid) 10 1
PB (mixed phenotype acute leukemia) 1 0
PB (total) 23 3
BM (lymphoid) 7 0
BM (non-lymphoid) 21 0
BM (total) 28 0

All enrolled specimens were stained within 23 hours of collection. All stained samples were acquired within
33 minutes of final resuspension. Samples with populations of aberrant immature hematopoietic cells were
identified as being non-lymphoid or lymphoid using the two systems, and compared. Samples identified as
being non-lymphoid included specimens with AUL. Samples identified as being lymphoid included

19 B-lymphoid lineage and 2 T-lymphoid lineage specimens.

Agreement was calculated as follows:

Overall % agreement = ((a+d)/(a+b+c+d))x100

Positive % agreement = (a/(a+c))x100
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Negative % agreement = (d/(d+b))x100
wherein,

a = number of samples identified as non-lymphoid for both systems,

b = number of samples identified as non-lymphoid on the BD FACSLyric™ flow cytometer but identified as lymphoid on the
BD FACSCanto™ II flow cytometer,

¢ = number of samples identified as lymphoid on the BD FACSLyric™ flow cytometer but identified as non-lymphoid on the
BD FACSCanto™ II flow cytometer,

d = number of samples identified as lymphoid for both systems.
The results for samples identified as non-lymphoid or lymphoid were tabulated. One evaluable specimen
was excluded from the table because it was a mixed phenotype acute leukemia. See the following table.

Table 6 Agreement for aberrant immature hematopoietic cells being lymphoid or non-lymphoid

Comparator method (BD FACSCanto™ II flow
cytometer)
Non-lymphoid Lymphoid Total
Investigational method (BD FACSLyric™ flow Non- 32 0 32
cytometer) lymphoid
Lymphoid 0 21 21
Total 32 21 53

Overall % agreement is 100%. The lower 95% confidence limit is 95.75%.

The positive agreement for specimens identified as non-lymphoid is 100%. The negative agreement for
specimens identified as lymphoid is 100%.

Equivalency (BD FACSLyric™ flow cytometer)

A qualitative assessment of the cell populations for the presence or absence of critical BD OneFlow™ ALOT
markers was performed for each evaluable specimen enrolled in the method comparison study. Specimens
were analyzed using the BD OneFlow™ system on the BD FACSLyric™ flow cytometer and the

BD FACSCanto™ II flow cytometer as described previously. Overall agreement of the two systems in
assessing the expression, either positive or negative, of the indicated markers in the specimens was
calculated. See the following table.

Table 7 Agreement for qualitative marker expression on BD FACSLyric™ and BD FACSCanto™ 11
flow cytometers

No. of % Overall agreement for Lower 95% CL of %
Marker specimens the expression of marker overall agreement
CD45"9 4™ 54 100% 95.83%
CD45™Y"™ and cyCD3* 54 100% 95.83%
CD45™%™ and CD3* 54 100% 95.83%
CD45™%"™ and CD19* 54 100% 95.83%
CD45™Y™ and cyCD79a* 54 100% 95.83%
CD45™Y*™ and cyMPO* 54 100% 95.83%
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No. of % Overall agreement for Lower 95% CL of %
Marker specimens the expression of marker overall agreement
CD45™9“™ and CD7* 54 100% 95.83%
CD45™9"™ and CD34* 54 100% 95.83%

The results of the method comparison and equivalency studies indicate that the two systems are
substantially equivalent.

Method comparison, BD FACS™ Universal Loader vs manual acquisition

A study was performed at one site to demonstrate equivalency between acquisition using the BD FACS™
Universal Loader and manual acquisition. Bone marrow specimens from normal and abnormal subjects were
stained using a minimum of 3 lots of BD OneFlow™ ALOT. For each specimen, 10 stained replicates were
acquired either manually or using the BD FACS™ Universal Loader (using the 30-tube and 40-tube racks).

The mean, absolute bias, and 95% confidence interval (CI) for acquisition using the BD FACS™ Universal
Loader vs manual acquisition were determined for the indicated populations. See the following table.

Table 8 BD FACS™ Universal Loader vs manual acquisition for BD OneFlow™ ALOT

Mean Absolute % bias
Cell Population N Loader Manual (95% CI)
Leukocytes (%SSC singlets) 24 99.98 99.97 0.01
(-0.01,0.03)
CD19" cells (%Leukocytes) 24 15.10 15.00 0.1
(-0.02,0.23)
B cells (%CD19%) 24 77.68 77.06 0.63
(-0.24,1.49)
cyCD3" cells (%Leukocytes) 24 13.91 13.72 0.20
(-0.05, 0.45)
T cells (%cyCD3") 24 93.42 92.59 0.83
(0.19, 1.48)
cyMPO" cells (%Non-lymphoid) 24 78.46 77.72 0.75
(0.12,1.37)
CD34" cells (%Leukocytes) 24 6.71 6.67 0.04
(-0.06, 0.14)

The results were also assessed qualitatively by a flow cytometry expert for concordance between samples
acquired manually and samples acquired using the Loader. All samples stained with BD OneFlow™ ALOT
showed 100% agreement.

19



Precision, within-site, control material (BD FACSLyric™ flow cytometer)

A 21-day single-site precision study was performed to assess the within-site precision (repeatability and
reproducibility) of BD OneFlow™ ALOT using control material. Estimates of precision were determined across
three BD FACSLyric™ flow cytometers and a minimum of three operators by acquiring CD-Chex CD34°,
stained in duplicate by each operator using three lots of BD OneFlow™ ALOT. Two separate runs were
performed by each operator on each of the 21 tested days.

Eight cell populations were identified as being a percentage of the parent population. Repeatability (within-
run variability) and reproducibility (variability between runs, between days, between operators, between
lots, and between instruments) were estimated. A total of 828 samples were analyzed. The mean, standard
deviation (SD), and coefficient of variation (%CV) is presented for each population. In addition, the one-
sided 95% confidence limit (Upper SD or Upper %CV) for the total system precision was calculated.

Table 9 Summary of within-site precision of subset percentages for BD OneFlow™ ALOT

Population Repeatability Reproducibility Total precision

(% of positive) Mean SD %CV SD %CV Upper SD Upper %CV
CD45* 34.73 1.11 3.20 212 0.06 283 8.16
CD19* 4.55 0.09 2.08 0.33 0.07 0.36 7.90
cyCD3* 23.71 0.66 2.77 0.93 0.04 1.42 598
CD3* 96.48 1.60 1.66 6.96 0.07 7.67 7.95
CD7* 89.29 0.75 0.84 6.40 0.07 6.92 7.76
cyCD79a" 95.11 215 2.26 1.63 0.02 2.83 298
CD34" 1.57 0.05 3.34 0.16 0.10 0.22 13.87
cyMPO* 9417 3.24 3.44 475 0.05 6.07 6.45

Precision, multi-site, control material (BD FACSLyric™ flow cytometer)

Multi-site precision was evaluated across three sites using one lot of BD OneFlow™ ALOT to stain three
replicates of CD-Chex CD34°. Two runs per day were acquired on a BD FACSLyric™ flow cytometer by one
operator per site over a period of 5 days.

Twelve cell populations were identified as being a percentage of the parent population. Repeatability
(within-run variability) and reproducibility (variability between runs, between days, and between sites) were
estimated. The mean, standard deviation (SD), and coefficient of variation (%CV) is presented for each
population. A total of 90 samples were analyzed. In addition, the one-sided 95% confidence limit (Upper SD
or Upper %CV) for the total system precision was calculated.

Table 10 Summary of multi-site precision of subset percentages for BD OneFlow™ ALOT

Population Repeatability Reproducibility Total precision

(% of positive) Mean sD %CV SD %CV Upper SD Upper %CV
CD45* 35.97 0.64 1.77 0.49 0.01 0.97 2.70
CD19* 4.00 0.07 1.80 0.04 0.01 0.10 2.43
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Population Repeatability Reproducibility Total precision

(% of positive) Mean SD %CV SD %CV Upper SD Upper %CV
cyCD3* 27.08 1.29 475 0.85 0.03 1.97 7.27
CD3* 93.22 2.03 217 2.44 0.03 5.51 5.91
cD7* 86.78 2.23 2.57 1.48 0.02 3.42 3.94
cyCD79a’ 97.19 0.64 0.66 0.58 0.01 1.10 113
CD34" 1.64 0.04 252 0.09 0.05 0.23 13.86
cyMPO* 93.49 0.81 0.87 0.89 0.01 1.63 1.74

Detection capability, limit of detection (BD FACSLyric™ flow cytometer)

The detection capability of BD OneFlow™ ALOT was assessed. An abnormal specimen was added to a
hematologically normal bone marrow specimen such that the abnormal population was at 0%, 0.02%,
0.05%, or 0.1% of all events of the normal specimen. Two sets of abnormal and normal specimens and 2 lots
of BD OneFlow™ ALOT were evaluated in the study.

Table 11 Detection capability of BD OneFlow™ ALOT

Number Mean actual %
Target Expected % disease abnormal cells SD of bias Trueness (95%
population abnormal cells N¢ samples (95% CIY) (Upper 95% CI) | lower bound)
CD45"evdm 0.000 20 0 0.000 N/AC N/A
CD34" (0.000, 0.001)
cyMPO 0.020 20 20 0.017 0.0023 100
(0.016,0.018) (0.0043) (88.1)
0.050 20 20 0.044 0.0032 100
(0.043, 0.046) (0.0059) (88.1)
0.100 20 20 0.092 0.0038 100
(0.090, 0.094) (0.0071) (88.1)

a. N = Number of replicates

b. CI = Confidence interval

c. N/A = Not applicable

Based on the results, a detection capability of 0.03% of all events is recommended for BD OneFlow™ ALOT.

BD FACSCanto™ II Flow Cytometer

Method comparison, BD FACSCanto™ II flow cytometer vs EuroFlow system

A side-by-side comparison study between the BD OneFlow™ system on the BD FACSCanto™ 11 flow
cytometer and the EuroFlow system on the BD FACSCanto™ II flow cytometer was performed at 5 external
clinical sites. The BD OneFlow™ system comprises BD OneFlow™ Setup Beads, BD® FC Beads for
compensation, and the BD OneFlow™ ALOT reagent. The EuroFlow reference system comprises Sphero™
Rainbow calibration particles (8 peaks), single color stained cells for compensation, and the corresponding
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EuroFlow reagent cocktails. Both methods used BD FACSDiva™ CS&T IVD beads to perform instrument
quality control. Aberrant immature hematopoietic cell populations from 93 patients were identified using
the two systems, and compared. A total of 37 PB specimens and 56 BM specimens were enrolled in the
study. PB and BM specimens were stained within 24 hours of collection. The stained samples were acquired
within 45 minutes of staining. Samples with populations of immature hematopoietic cells were identified as
being non-lymphoid or lymphoid. Samples identified as being non-lymphoid included specimens with AUL.
Samples identified as being lymphoid included 37 B-lymphoid lineage and 7 T-lymphoid lineage specimens.

Agreement was calculated as follows:

Overall % agreement = ((a+d)/(a+b+c+d))x100

wherein,

a = number of samples identified as non-lymphoid for both systems,
b = number of samples identified as non-lymphoid for the BD OneFlow™ system but identified as lymphoid for the EuroFlow system,

¢ = number of samples identified as lymphoid for the BD OneFlow™ system but identified as non-lymphoid for the Euroflow system,
and

d = number of samples identified as lymphoid for both systems.

The results for samples identified as non-lymphoid or lymphoid were tabulated. See the following table.

Table 12 Agreement for aberrant immature hematopoietic cells being lymphoid or non-lymphoid

Comparator method (EuroFlow system)

Non-lymphoid Lymphoid Total
Investigational method (BD OneFlow™ system) Non-lymphoid 49 0 49
Lymphoid 0 44 44
Total 49 44 93

Overall % agreement is 100%. The lower 95% confidence limit is 96.8%.

Equivalency (BD FACSCanto™ II flow cytometer)

A qualitative assessment of the cell populations for the presence or absence of critical BD OneFlow™ ALOT
markers was performed for each specimen. Specimens were analyzed using the BD OneFlow™ system and
the corresponding EuroFlow system described previously. Overall agreement of the two systems in assessing
the expression, either positive or negative, of the indicated markers in the specimens was calculated. See the
following table.

Table 13 Equivalency of the BD OneFlow™ system to the EuroFlow system

% Overall agreement for the expression of Lower 95% CL of % overall
Marker marker agreement
CD45"9 4™ 100% 96.8%
CD45™9"™ and cyCD3 100% 96.8%
CD45™¥"™ and CD3 100% 96.8%
CD45™"™and CD19 100% 96.8%
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% Overall agreement for the expression of Lower 95% CL of % overall
Marker marker agreement
CD45™Y"™ and cyCD79a 100% 96.8%
CD45™Y"™ and cyMPO 100% 96.8%

The results of the method comparison and equivalency studies indicate that the two systems are
substantially equivalent.

Precision (BD FACSCanto™ II flow cytometer)

Precision studies for the reproducibility and repeatability of BD OneFlow™ ALOT were performed at
BD Biosciences laboratories in San Jose, CA, USA.

Two operators each performed two separate runs per day on either of two BD FACSCanto™ II flow
cytometers. The operators switched to the other instrument each day over a period of eight days. For each
run, duplicate samples of CD-Chex CD34° were stained using three lots of BD OneFlow™ ALOT by each
operator, and then acquired and analyzed using the BD OneFlow™ ALOT template in BD FACSDiva™
software.

Reproducibility

Three cell populations were identified as being a percentage of the cell populations indicated in the table.
The reproducibility of the subset percentages was calculated for each cell population. Reproducibility
comprises four components: operator/instrument-to-operator/instrument, lot-to-lot, run-to-run, and
day-to-day reproducibility.

Table 14 Reproducibility of subset percentages

Population Mean SD¢ Upper 95% CL® of SD %CV* Upper 95% CL of %CV
T cells (% leukocytes) 29.0 0.2 0.6 0.7 1.9

B cells (% leukocytes) 5.7 0.1 0.6 23 10.0

cyMPO" cells (% leukocytes) 54.8 1.1 4.8 20 8.8

a. SD = Standard deviation

b. CL = Confidence limit

c. %CV = % Coefficient of variation

Repeatability

Three cell populations were identified as being a percentage of the cell populations indicated in the table.
The within-run precision (tube-to-tube repeatability) of the subset percentages was calculated for each cell
population.

Table 15 Repeatability of subset percentages

Population Mean SD Upper 95% CL of SD %CV Upper 95% CL of %CV
T cells (% leukocytes) 29.0 0.5 0.5 1.7 1.9
B cells (% leukocytes) 5.7 0.1 0.2 25 28
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Population

Mean SD

Upper 95% CL of SD %CV Upper 95% CL of %CV

cyMPO" cells (% leukocytes)

54.8 0.8 0.9 1.4 1.6

10. TROUBLESHOOTING

Problems with cell preparation or staining

Problem

Possible Cause

Solution

The resolution
between debris and
cells is poor.

Specimen was over-
permeabilized.

Repeat staining. Incubate the tube in FIX&PERM Reagent B for
15 minutes only.

Specimen is of poor
quality.

Check cell viability.

Specimen is too old.

Obtain a new specimen and stain it immediately.

The cytoplasmic
staining (cyMPO,
cyCD79q, cyCD3) is
dim.

The cells were not
completely
permeabilized.

Repeat staining. Carefully measure the specimen volumes in the cell
fixation and permeabilization steps such that the ratio of fixed
sample to FIX&PERM Reagent B is 1:1.

Cells clump after
being fixed.

Cells were not
completely
resuspended before
fixing them.

Vortex tubes until no cell aggregates remain before adding
FIX&PERM Reagent A. If needed, gently pipette the sample up and
down until no cell aggregates remain.

Cells were not
thoroughly washed
after fixing them.

Incubate the tubes for 2 minutes in the dark in wash buffer after
they have been fixed using FIX&PERM Reagent A.

Staining is dim or
fading.

Cell concentration was
too high at the
staining step.

Check the cell concentration and adjust as needed.

The BD OneFlow™
tube was exposed to
light for too long.

Repeat staining with a new BD OneFlow™ tube.

Stained cells were
stored too long before
acquiring them.

Repeat staining with a fresh specimen and acquire it promptly.

Few or no cells are
recorded.

Cell concentration was
too low.

Resuspend fresh specimen at a higher concentration. Repeat
staining and acquisition.

Cytometer is
malfunctioning.

Troubleshoot the instrument. See the cytometer instructions for use
for more information.
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Problems using the reagent on BD FACSLyric™ flow cytometers:

Problem

Possible Cause

Solution

Not enough cells of
interest are
acquired.

Cell concentration was too
low.

Resuspend fresh specimen at a higher concentration. Repeat
staining and acquisition.

The default setting of
100,000 events acquired is
too low.

Change the number of events acquired. Repeat staining and
acquisition. See the BD OneFlow™ Application Guide for Acute
Leukemias for BD FACSLyric™ Flow Cytometers.

The FSC-A vs SSC-A
dot plot is
abnormal.

Cytometer needs adjusting.

Contact BD Biosciences.

The csv file and
report are not
exported

The reagent lot number and
expiration date were not
added to the Library.

1. Add the reagent lot number and expiration date to the
Library.
2. Export the csv file and the report PDF manually. See the

automatically.

BD FACSLyric™ System Instructions For Use.

Problems using the reagent on BD FACSCanto™ II flow cytometers:

Problem

Possible Cause

Solution

The resolution between
debris and lymphocytes is
poor.

Instrument
settings are
inappropriate.

Follow proper instrument setup procedures. See the Instrument
Setup Guide for BD OneFlow™ Assays.

Some of the dot plots are
dimmed.

FSC-H and SSC-H
were not selected
when the
application
settings were
created.

Check that FSC-H and SSC-H are selected on the Parameters tab of
the Inspector.

The barcode on the

BD OneFlow™ ALOT (C)
tube label cannot be
scanned.

The barcode on
the tube label has
been
compromised.

Scan the barcode on the BD OneFlow™ ALOT (C) pouch label into
the Product ID keyword field in the Experiment Layout. Next, after
the last digit of the barcode, manually enter a semicolon (;)
followed by the six-digit tube-specific ID, found adjacent to the
barcode on the tube label.

The dot plots on the
worksheets are missing or
the dot plots do not have
gates.

The template did
not import
correctly.

1. Close the current experiment.
2. Create a new experiment.
3. Re-import the BD OneFlow™ ALOT template.
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Problem Possible Cause Solution

Some of the keywords are | BD 1. Inthe Browser, set the current tube pointer to the tube that you
missing from the statistics | FACSDiva™ are analyzing. )
box in the analvsis software did not 2. Navigate to the analysis worksheet.
y ; 3. Right-click the statistics box and select Edit Stats View.

worksheet. import allof the |/, 15the Header tab, select the All checkbox.

keywords into the | 5. (Click OK.

panel template.
The statement, For in vitro | The paper 1. From the BD FACSDiva™ software menu bar, select File > Page

Setup.

diagnostic use, does not margins in the . .
. . . 2. Ensure that all of the margins are set to 2.54 cm or 1 inch,
appear in the footer of the | printer settings depending on your default standards.

analysis worksheet when it | were changed. 3. Click OK.
is printed.
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NOTICE

EU Only: Users shall report any serious incident related to the device to the Manufacturer and National
Competent Authority.

Outside EU: Contact your local BD representative for any incident or inquiry related to this device.

Refer to the Eudamed website: https://ec.europa.eu/tools/eudamed for Summary of Safety and
Performance.

WARRANTY

Unless otherwise indicated in any applicable BD general conditions of sale for non-US customers, the
following warranty applies to the purchase of these products.

THE PRODUCTS SOLD HEREUNDER ARE WARRANTED ONLY TO CONFORM TO THE QUANTITY AND CONTENTS STATED ON THE
LABEL OR IN THE PRODUCT LABELING AT THE TIME OF DELIVERY TO THE CUSTOMER. BD DISCLAIMS HEREBY ALL OTHER
WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING WARRANTIES OF MERCHANTABILITY AND FITNESS FOR ANY PARTICULAR
PURPOSE AND NONINFRINGEMENT. BD’S SOLE LIABILITY IS LIMITED TO EITHER REPLACEMENT OF THE PRODUCTS OR REFUND OF
THE PURCHASE PRICE. BD IS NOT LIABLE FOR PROPERTY DAMAGE OR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES,
INCLUDING PERSONAL INJURY, OR ECONOMIC LOSS, CAUSED BY THE PRODUCT.

PATENTS AND TRADEMARKS
For US patents that may apply, see bd.com/patents.

BD, the BD Logo, BD FACSDiva, BD FACSLyric, BD FACSuite, BD OneFlow, FACS, FACSCanto, Horizon and
Vacutainer are trademarks of Becton, Dickinson and Company or its affiliates. All other trademarks are the
property of their respective owners. © 2023 BD. All rights reserved.

Cy™ is a trademark of GE Healthcare. This product is subject to proprietary rights of GE Healthcare and
Carnegie Mellon University, and is made and sold under license from GE Healthcare. This product is licensed
for sale only for in vitro diagnostics. It is not licensed for any other use. If you require any additional license
to use this product and do not have one, return this material, unopened, to BD Biosciences, 155 North
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McCarthy Boulevard, Milpitas, California 95035, USA, and any money paid for the material will be refunded.

The EuroFlow trademark and logo and the EuroFlow™ antibody panels are property of the EuroFlow
Consortium and cannot be reproduced or published without prior written permission from the EuroFlow
coordinator (euroflow.org).

HISTORY

Revision Date Changes made

23-18878-01 2020-05 Revised to support using the product on BD FACSLyric™ flow cytometers.

23-18878-02 2021-01 Revised to support using the product with the BD FACS™ Universal Loader.

23-18878(03) 2023-01 Updated to meet requirements for Regulation (EU) 2017/746.

23-18878(04) 2023-10 Updated legal manufacturer address. Added EU and Swiss importer addresses
and importer symbol. Updated precautionary statements to align with SDS.
Updated symbols glossary.
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SYMBOLS GLOSSARY
Please refer to product labeling for applicable symbols.

Symbol Meaning

Manufacturer

Authorized representative in the European Community

Authorised representative in Switzerland

Symbol Meaning

@)

Single sterile barrier system

DEHP
BBP

Contains or presence of phthalate: combination of bis(2-ethylhexyl)
phthalate (DEHP) and benzyl butyl phthalate (BBP)

Date of manufacture

Use-by date

Batch code

X

Collect separately
Indicates separate collection for waste of electrical and electronic equipment
required.

Ce

CE marking; Signifies European technical conformity

Catalogue number

Serial number

Sterile

A

Device for near-patient testing

a

Device for self-testing

Sterilized using aseptic processing techniques

Sterilized using ethylene oxide

Sterilized using irradiation

Sterilized using steam or dry heat

Do not resterilize

I&Only

This only applies to US: “Caution: Federal Law restricts this device to
sale by or on the order of a licensed practitioner.”

Country of manufacture
“CC” shall be replaced by either the two letter or the three letter country
code.

Collection time

Non-sterile

Do not use if package is damaged and consult instructions for use

Sterile fluid path

Sterile fluid path (ethylene oxide)

Sterile fluid path (irradiation)

olr

X

Cut

Peel here

Collection date

=T

Keep away from light

F

Hydrogen gas is generated

Fragile, handle with care

Keep away from sunlight

Keep dry

Lower limit of temperature

Perforation

Start panel sequence number

O ®|@00) | @

End panel sequence number

Internal sequence number

Upper limit of temperature

B

<Box #> / <Total Boxes>

Temperature limit

Medical device

@[ s<|=< =<l B @ @ ERE

Contains hazardous substances

Humidity limitation

Ukrainian conformity mark

Biological risks

[MD)
KE

Meets FCC requirements per 21 CFR Part 15

Do not re-use

UL product certification for US and Canada

Consult instructions for use or consult electronic instructions for use

Unique device identifier

Caution

Importer

Contains or presence of natural rubber latex

Place patient label in framed area only

In vitro diagnostic medical device

Negative control

ICONTROL| +

MD|
&
<
C
@
[uD|]
®
O
@

Magnetic resonance (MR) safe

Positive control

Contains sufficient for <n> tests

VAN

>

Magnetic resonance (MR) conditional

For IVD performance evaluation only

®

Magnetic resonance (MR) unsafe

[This Product Contains Dry Natural Rubber| This Product Contains Dry Natural Rubber

Non-pyrogenic

For Export Only | For Export Only

Patient number

This way up

-m::?'X@@;EEG%E@

Do not stack

Note: Text layout in symbols is determined by label design.
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CONTACT INFORMATION

el

[Ec [Ree]

[cH [ree]

Becton, Dickinson and Company
BD Biosciences

155 North McCarthy Boulevard
Milpitas, California 95035 USA

Becton Dickinson Ireland Ltd.
Donore Road, Drogheda

Co. Louth, A92 YW26

Ireland

Becton Dickinson Distribution Center NV
Laagstraat 57
9140 Temse, Belgium

BD Switzerland Sarl
Route de Crassier 17
Business Park Terre-Bonne
Batiment A4

1262 Eysins

Switzerland

Becton Dickinson AG
Binningerstrasse 94
4123 Allschwil
Switzerland

BD Biosciences

European Customer Support
Tel +32.53.720.600
help.biosciences@bd.com

Australian and New Zealand Distributors:

Becton Dickinson Pty Ltd.
66 Waterloo Road
Macquarie Park NSW 2113
Australia

Becton Dickinson Limited
14B George Bourke Drive

Mt. Wellington Auckland 1060
New Zealand

Technical Service and Support: Contact your local
BD representative or bdbiosciences.com.

ClinicalApplications@bd.com

eifu.bd.com
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